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chapter 1

Introduction
This guide documents how to upgrade to 
Pro Tools® 8.0 for Pro Tools HD® systems on a 
Digidesign®-qualified Windows or Mac com-
puter. 

If you are installing Pro Tools on a Mac com-
puter, see Chapter 2, “Installing Pro Tools on 
Mac.”

If you are installing Pro Tools on a Windows 
computer, see Chapter 3, “Installing Pro Tools 
on Windows.”

Before installing this version of Pro Tools, 
refer to the Read Me information included 
on the Pro Tools Installer disc.

If you are configuring a new Pro Tools sys-
tem, follow the complete hardware and soft-
ware installation steps in the Setup Guide 
that came with your system.
System Requirements and 
Compatibility Information
Pro Tools HD software can be used on a 
Pro Tools|HD system on a Digidesign-qualified 
Windows or Mac computer.

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved. 

For complete system requirements and a list of 
Digidesign-qualified computers, operating sys-
tems, hard drives, and third-party devices, refer 
to the latest information on the Digidesign web-
site:

www.digidesign.com/compatibility

Internet Access

Upgrading to any version of Pro Tools requires 
access to the Internet for software activation and 
registration purposes.

DVD Drive

The Pro Tools Installer disc requires a DVD drive 
for installation.
Chapter 1: Introduction 1
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chapter 2

Installing Pro Tools on Mac
This chapter explains how to install and config-
ure Pro Tools for Pro Tools|HD systems on a 
Digidesign-qualified Mac computer.

For complete system requirements and compat-
ibility information, visit the Digidesign website:

www.digidesign.com/compatibility

Before You Upgrade

Retaining Your Pro Tools Preferences

When you upgrade your Pro Tools HD software, 
Pro Tools Preferences settings are reset to their 
default settings. These default settings may dif-
fer from your previous settings. Therefore, you 
may want to note your current Preferences set-
tings before upgrading. See Appendix A, “Not-
ing Your Preferences” for tips on noting your 
current Pro Tools Preferences settings.

Read Mes

Before installing this version of Pro Tools, refer 
to the Read Me information included on the 
Pro Tools Installer disc.

If you are installing Pro Tools HD on a 
Windows computer, see Chapter 3, “In-
stalling Pro Tools on Windows.”
Important Information about Structure and 
Xpand! Plug-ins

If the full version of Structure® or Structure LE is 
already installed on your system, Structure Free 
will not be installed.

If Xpand!® is already installed on your system, 
installing Xpand!2 will overwrite Xpand! All 
Xpand! presets are copied to the Xpand!2 Plug-
in Presets folder and will be available in 
Xpand!2.

Installation Overview
Installation of Pro Tools software on a Mac com-
puter includes the following steps:

1  Authorizing Pro Tools software. See “Autho-
rizing Pro Tools Upgrades” on page 4.

2  Installing Pro Tools HD software. See “Install-
ing Pro Tools HD Software” on page 4.

3  Launching Pro Tools. See “Launching 
Pro Tools HD” on page 5.

4  Configuring your system for improved perfor-
mance. (See your system’s Setup Guide.)
Chapter 2: Installing Pro Tools on Mac 3
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Authorizing Pro Tools 
Upgrades
Before you install your Pro Tools upgrade, you 
must obtain an iLok license to authorize the 
Pro Tools application. The process for getting 
the authorization license depends on how you 
purchased it.

If you purchased a software upgrade online, 
follow the instructions provided online.

If you purchased a boxed Pro Tools software 
upgrade, you need to use an Activation Code 
(located on the Activation Card) to get the au-
thorization license. See “Authorizing Boxed 
Pro Tools Upgrades” on page 4.

Authorizing Boxed Pro Tools 
Upgrades

For Pro Tools HD software upgrades, your soft-
ware is protected by an iLok license. The autho-
rization procedure will allow you to move your 
Pro Tools software upgrade license from your 
iLok.com account to your iLok USB Smart Key, 
so that you can run Pro Tools.

If you have not already completed authorizing 
your software by following the instructions on 
the Activation Card, complete the following 
steps.

To authorize a boxed Pro Tools HD upgrade using 
an Activation Code:

1  Locate the enclosed Activation Card. The 
unique code on this card will allow you to re-
trieve your iLok license.

2  If you do not have an existing iLok.com ac-
count, visit www.iLok.com and sign up for a free 
iLok.com account.
Upgrading to Pro Tools HD 8.0
3  Visit www.digidesign.com/activation, enter 
your activation code, and click Continue. If 
you’re not already logged in to your Digidesign 
(My Digi) account, you will be asked to log in us-
ing the email address you used to set up the ac-
count. If you don’t already have an account, 
click Create Profile to create one

4  Visit ilok.com, log in to your account, and fol-
low the instructions to transfer the license from 
your account to your iLok USB Smart Key.

5  Proceed to “Installing Pro Tools HD Software” 
on page 4

Installing Pro Tools HD 
Software

To install Pro Tools HD software:

1  Make sure you are logged in as an Administra-
tor for the account where you want to install 
Pro Tools. For details on Administrator privi-
leges in Mac OS X, refer to your Apple OS X doc-
umentation. 

2  Do one of the following:

• If you purchased a software upgrade online, 
follow the instructions provided with it to ex-
pand and launch the installer.

– or –

• If you purchased a boxed version Pro Tools 
upgrade, do all of the following:

• Insert the Pro Tools Installer disc for Win-
dows in your DVD drive. 

• Locate and double-click the Install 
Pro Tools HD.mpkg file.

3  Follow the on-screen instructions to proceed 
with installation.

4  When prompted to select features to install, 
leave the default options selected.



5  You can also select from a list of optional 
items to install along with Pro Tools:

Avid Video Engine The Avid® Video Engine is re-
quired to use Pro Tools with Avid video periph-
erals such as the Avid Mojo or the Digidesign 
AVoption|V10. 

MIDI I/O Driver The MIDI I/O™ Driver is re-
quired if you are using the Digidesign MIDI IO. 

6  Click Install.

7  If prompted, enter your Administrator pass-
word and click OK to accept the installation.

8  Select your work environment. This loads an 
initial set of Pro Tools Preferences that include 
some of the more popular settings for post pro-
duction, audio, or audio with MIDI. 

9  Click Continue.

10  When installation is complete, click Restart.

The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Additional Software on the 
Pro Tools Installer Disc” on page 6.

Preference settings can be customized at any 
time in Pro Tools. see the Pro Tools Refer-
ence Guide for more information.
Launching Pro Tools HD
When you launch Pro Tools HD, you must have 
your iLok with a license that authorizes the ver-
sion of Pro Tools HD software you are using.

For instructions on getting authorization for 
your Pro Tools HD software upgrade, see “Au-
thorizing Pro Tools Upgrades” on page 4

To launch Pro Tools HD software:

1  Make sure HD hardware is connected to your 
computer system.

2  Insert the your authorized iLok into an avail-
able USB port on your computer.

3  Do one of the following:

• Click the Pro Tools HD icon in the Dock.

– or –

• Locate and double-click the Pro Tools HD 
application on your hard drive.

Do not remove the iLok during Pro Tools 
launch or use.
Chapter 2: Installing Pro Tools on Mac 5
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4  Use the Quick Start dialog to do one of the fol-
lowing:

• Create a new session from a template.

• Create a new blank session. 

• Open a recent session.

• Open a session.

Configuring Pro Tools
You can adjust the performance of your system 
by changing certain Pro Tools system settings 
that affect its capacity for processing, playback, 
and recording. 

In most cases, the default settings for your sys-
tem provide optimum performance, but you 
may want to adjust them to accommodate large 
or processing-intensive Pro Tools sessions.

Refer to the HD Setup Guide for instructions on 
configuring Pro Tools settings.

Quick Start dialog showing session template window

For more information on the Quick Start di-
alog and session templates, see the 
Pro Tools Reference Guide.
Upgrading to Pro Tools HD 8.0
Additional Software on the 
Pro Tools Installer Disc
The Pro Tools Installer disc provides additional 
software for your system, including audio driv-
ers (for playing other audio applications 
through your Digidesign hardware) and a 
Pro Tools demo session.

Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. 

Installers are located on your Pro Tools Installer 
disc in the Additional Files > 3rd Party Content 
folder.

Check your Pro Tools Installer disc for addi-
tional software and installers.



Digidesign CoreAudio Driver

The Digidesign CoreAudio Driver lets you use 
your Digidesign-qualified audio interfaces with 
third-party applications that support the 
CoreAudio Driver standard.

The following Pro Tools system interfaces are 
supported:

• Pro Tools|HD

• 003®

• 003 Rack

• 003 Rack+

• Digi 002®

• Digi 002 Rack

• Mbox®

The Digidesign CoreAudio Driver for your 
Digidesign hardware is automatically installed 
when you install Pro Tools.

Standalone Digidesign CoreAudio Drivers

Digidesign CoreAudio Drivers can be installed 
on Mac systems that do not have Pro Tools soft-
ware installed.

For information on configuring the Digide-
sign CoreAudio Driver, see the CoreAudio 
Drivers Guide.

For information on installing and configur-
ing the standalone version of the Digidesign 
CoreAudio Driver, see the CoreAudio Driv-
ers Guide.
Pro Tools Demo Session

The Pro Tools HD Installer disc includes a demo 
session that you can use to verify that your sys-
tem is working. The demo session for 
Pro Tool HD is named Meant To Be.

To install the demo session:

1  Insert the Pro Tools Installer disc into your 
DVD drive. 

2  On the installer disc, in the Additional Files 
folder, locate and open the Pro Tools Demo Ses-
sion Installer folder.

3  Double-click the HD Demo Session Setup.pkg 
file.

4  Follow the on-screen instructions to proceed 
with installation.

5  When prompted, select your audio drive as 
the install location and click Continue to begin 
the install.

6  Click Install.

7  When installation is complete, click Close.

The demo session can be opened by double-
clicking the Meant To Be.ptf file located in the 
Pro Tools HD Demo Session folder.

Before installing the demo session to your 
audio drive, make sure the drive is config-
ured as described in your Setup Guide.
Chapter 2: Installing Pro Tools on Mac 7
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Uninstalling Pro Tools
If you need to uninstall Pro Tools software from 
your computer, use the Uninstall Pro Tools ap-
plication. 

To uninstall Pro Tools from your computer:

1  Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed. 

2  Go to Applications/Digidesign/Pro Tools/
Pro Tools Utilities and double-click the 
Uninstall Pro Tools.app file.

3  Click Continue to proceed with the uninstall.

4  Choose the type of uninstall you want to per-
form:

Safe Uninstall Leaves certain plug-ins and sys-
tem files needed for compatibility with some 
Avid products. Use Safe Uninstall if you are us-
ing an Avid application.

Clean Uninstall Removes all Pro Tools files, in-
cluding system files, Digidesign plug-ins, and 
MIDI patch names. Use Clean Uninstall when-
ever you are preparing to upgrade, or to trouble-
shoot from a clean system.

5  Click Uninstall. 

6  Enter your Administrator password and click 
OK. 

7  Click Finish to close the Installer window.

For details on Administrator privileges in 
Mac OS X, see your Apple OS X documen-
tation. 
Upgrading to Pro Tools HD 8.0
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Installing Pro Tools on Windows
This chapter explains how to install Pro Tools 
for Pro Tools|HD systems on a Digidesign-quali-
fied Windows computer.

For complete system requirements and compat-
ibility information, visit the Digidesign website:

www.digidesign.com/compatibility

Before You Upgrade

Retaining Your Pro Tools Preferences

When you upgrade your Pro Tools HD software, 
Pro Tools Preferences settings are reset to their 
default settings. These default settings may dif-
fer from your previous settings. Therefore, you 
may want to note your current Preferences set-
tings before upgrading. See Appendix A, “Not-
ing Your Preferences” for tips on noting your 
current Pro Tools Preferences settings.

Read Mes

Before installing this version of Pro Tools, refer 
to the Read Me information included on the 
Pro Tools Installer disc.

If you are installing Pro Tools HD on a Mac 
computer, see Chapter 2, “Installing 
Pro Tools on Mac.”
Important Information about Structure and 
Xpand! Plug-ins

If the full version of Structure or Structure LE is 
already installed on your system, Structure Free 
will not be installed.

If Xpand! is already installed on your system, 
installing Xpand!2 will overwrite Xpand! All 
Xpand! presets are copied to the Xpand!2 Plug-
in Presets folder and will be available in 
Xpand!2.

Installation Overview
Installation of Pro Tools software on a Windows 
computer includes the following steps:

1  Authorizing Pro Tools software. See “Autho-
rizing Pro Tools Upgrades” on page 10.

2  Installing Pro Tools software. See “Installing 
Pro Tools HD Software” on page 10.

3  Installing QuickTime software. (See “Install-
ing QuickTime” on page 11)

4  Launching Pro Tools. See “Launching Pro 
Tools HD Software” on page 12.

5  Configuring your system for improved perfor-
mance. (See the HD Setup Guide.)
Chapter 3: Installing Pro Tools on Windows 9
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Authorizing Pro Tools 
Upgrades
Before you install your Pro Tools upgrade, you 
must obtain an iLok license to authorize the 
Pro Tools application. The process for getting 
the authorization license depends on how you 
purchased it.

If you purchased a software upgrade online, 
follow the instructions provided online.

If you purchased a boxed Pro Tools software 
upgrade, you need to use an Activation Code 
(located on the Activation Card) to get the au-
thorization license. See “Authorizing Boxed 
Pro Tools Upgrades” on page 10.

Authorizing Boxed Pro Tools 
Upgrades

For Pro Tools HD software upgrades, your soft-
ware is protected by an iLok license. The autho-
rization procedure will allow you to move your 
Pro Tools software upgrade license from your 
iLok.com account to your iLok USB Smart Key, 
so that you can run Pro Tools.

If you have not already completed authorizing 
your software by following the instructions on 
the Activation Card, complete the following 
steps.

To authorize a boxed Pro Tools HD upgrade using 
an Activation Code:

1  Locate the enclosed Activation Card. The 
unique code on this card will allow you to re-
trieve your iLok license.

2  If you do not have an existing iLok.com ac-
count, visit www.iLok.com and sign up for a free 
iLok.com account.
Upgrading to Pro Tools HD 8.0
3  Visit www.digidesign.com/activation, enter 
your activation code, and click Continue. If 
you’re not already logged in to your Digidesign 
(My Digi) account, you will be asked to log in us-
ing the email address you used to set up the ac-
count.If you don’t already have an account, 
click Create Profile to create one

4  Visit ilok.com, log in to your account, and fol-
low the instructions to transfer the license from 
your account to your iLok USB Smart Key.

5  Proceed to “Installing Pro Tools HD Software” 
on page 10.

Installing Pro Tools HD 
Software

To install Pro Tools HD software:

1  Start Windows, logging in with Administrator 
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2  Uninstall your older version of Pro Tools. See 
“Uninstalling Pro Tools” on page 15 for more 
information on uninstalling Pro Tools.

3  Do one of the following:

• If you purchased a software upgrade online, 
follow the instructions provided with it to ex-
pand the installer. 

– or –

• If you purchased a boxed version Pro Tools 
upgrade, do all of the following:

• Insert the Pro Tools Installer disc for Win-
dows in your DVD drive. 

• Locate and double-click the Setup icon.

In Windows Vista, if the User Account 
Control dialog appears, click Allow.



4  When prompted to select features to install, 
leave the default options selected.

5  You can also select from a list of optional 
items to install along with Pro Tools.

Mac HFS+ Disk Support Option This option lets 
your Pro Tools system read, write, record, and 
play back using Mac-formatted HFS+ disks. HFS+ 
disks are commonly referred to as Mac OS Ex-
tended disks.

Avid Video Engine The Avid Video Engine is re-
quired to use Pro Tools with Avid video periph-
erals such as the Avid Mojo or the Digidesign 
AVoption|V10. 

Command|8 Controller and Driver The Com-
mand|8® Driver is required if you are using the 
Digidesign Command|8 control surface.

6  Click Next.

7  Select your work environment. This loads an 
initial set of Pro Tools Preferences that include 
some of the more popular settings for post pro-
duction, audio, or audio with MIDI. 

8  Click Next.

The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Additional Software on the 
Pro Tools Installer Disc” on page 13.

Preference settings can be customized at any 
time in Pro Tools. See the Pro Tools Refer-
ence Guide for more information.
9  Click Install.

10  Wait for the installer to finish installing all 
software components, drivers, and PACE System 
files before proceeding to the next step. 

11  When installation is complete, click Finish.

12  If QuickTime is not installed, proceed to “In-
stalling QuickTime” on page 11.

Installing QuickTime
A Digidesign-qualified version of QuickTime is 
required for Pro Tools if you plan to include 
movie files, or import MP3 or MP4 (AAC) files in 
your sessions. QuickTime for Windows is avail-
able as a free download from the Apple website 
(www.apple.com).

In Windows XP, a series of Software Instal-
lation dialogs about the driver not passing 
Windows Logo testing may appear. Click 
Continue Anyway on each one until they go 
away.

If any other dialogs appear (such as the 
“Found New Hardware” dialog), leave them 
open and do not click on them. These dia-
logs will close on their own.

In Windows Vista, a series of Windows Se-
curity dialogs may appear.Click “Install” 
on each one until they go away.

For information on which version of Quick-
Time is compatible with your version of 
Pro Tools, visit the compatibility pages of 
the Digidesign website
(www.digidesign.com/compatibility).
Chapter 3: Installing Pro Tools on Windows 11
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To install QuickTime:

1  Visit www.apple.com and go to the Quick-
Time page.

2  Download the QuickTime installer applica-
tion to your computer.

3  Double-click the QuickTime installer applica-
tion and follow the on-screen installation in-
structions.

4  Restart your computer.

Launching Pro Tools HD 
Software
When you launch Pro Tools HD, you must have 
your iLok with a license that authorizes the ver-
sion of Pro Tools HD software you are using.

For instructions on getting authorization for 
your Pro Tools HD software upgrade, see “Au-
thorizing Pro Tools Upgrades” on page 10

To launch Pro Tools HD software:

1  Make sure HD hardware is connected to your 
computer.

2  Insert your iLok into an available USB port on 
your computer.

3  Do one of the following:

• Double-click the Pro Tools HD shortcut on 
the desktop.

– or –

• Locate and double-click the Pro Tools HD 
application on your hard drive.
Upgrading to Pro Tools HD 8.0
4  Use the Quick Start dialog to do one of the fol-
lowing:

• Create a new session from a template.

• Create a new blank session. 

• Open a recent session.

• Open a session.

Quick Start dialog

For more information on the Quick Start di-
alog and session templates, see the 
Pro Tools Reference Guide.

Do not remove the iLok during Pro Tools 
launch or use.



Configuring Your System for 
Improved Performance
You can adjust the performance of your system 
by changing certain Pro Tools system settings 
that affect its capacity for processing, playback, 
and recording. 

In most cases, the default settings for your sys-
tem provide optimum performance, but you 
may want to adjust them to accommodate large 
or processing-intensive Pro Tools sessions.

In addition, you can configure your Windows 
system settings to ensure optimum performance 
with Pro Tools.

Refer to the electronic PDF version of the Setup 
Guide that was installed with your software for 
instructions on configuring Pro Tools and Win-
dows system settings.

Additional Software on the 
Pro Tools Installer Disc
The Pro Tools Installer disc provides additional 
software for your system, including audio driv-
ers (for playing other audio applications 
through your Digidesign hardware) and a 
Pro Tools demo session.

Check your Pro Tools Installer disc for addi-
tional software and installers.
Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. 

Installers are located on your Pro Tools Installer 
disc in the Additional Files > 3rd Party Content 
folder.

Windows Audio Drivers for Most 
Pro Tools Interfaces
(Pro Tools|HD, 003, 003 Rack, Digi 002, 
Digi 002 Rack, Mbox 2, Mbox 2 Mini, and 
Mbox Only)

The Digidesign ASIO Driver and WaveDriver 
Windows System Audio Driver let you use your 
Digidesign hardware interface with third-party 
applications that support the ASIO Driver or 
WaveDriver MME (Multimedia Extension). The 
following Pro Tools system interfaces are sup-
ported:

• Pro Tools|HD

• 003

• 003 Rack

• 003 Rack+

• Digi 002

• Digi 002 Rack

• Mbox 2

• Mbox 2 Mini

• Mbox
Chapter 3: Installing Pro Tools on Windows 13
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The Digidesign ASIO Driver and WaveDriver for 
your Digidesign hardware are automatically in-
stalled when you install Pro Tools.

Digidesign ASIO Driver

The Digidesign ASIO Driver is a single-client, 
multichannel sound driver that allows third-
party audio programs that support the ASIO 
Driver standard to record and play back through 
Digidesign-qualified Pro Tools audio interfaces.

Digidesign WaveDriver (Windows XP only)

The Digidesign WaveDriver Windows System 
Audio Driver is a single-client, multichannel 
sound driver that allows third-party audio pro-
grams that support the WaveDriver MME (Mul-
timedia Extensions) standard to play back 
through Digidesign-qualified Pro Tools audio 
interfaces.

Standalone Windows Audio Drivers

Digidesign Windows Audio Drivers can be in-
stalled on Windows systems that do not have 
Pro Tools software installed. Use the standalone 
version of the Digidesign Windows Audio Driv-
ers installer (Digidesign Audio Drivers 
Setup.exe), which is available on the Pro Tools 
Installer disc.

For specifications and configuration infor-
mation specific to each driver, see the Win-
dows Audio Drivers Guide.

For detailed information on configuring the 
Digidesign ASIO Driver, see the Windows 
Audio Drivers Guide.

For detailed information on configuring the 
Digidesign WaveDriver, see the Windows 
Audio Drivers Guide.
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Pro Tools Demo Session

The Pro Tools  Installer disc includes a demo ses-
sion that you can use to verify that your system 
is working. The demo session for Pro Tool HD is 
named Meant To Be.

To install the demo session:

1  Insert the Pro Tools Installer disc into your 
DVD drive. 

2  On the installer disc, in the Additional Files 
folder, locate and open the Pro Tools Demo Ses-
sion Installer folder.

3  Double-click the HD Demo Session Setup.exe 
file.

4  Follow the onscreen instructions to proceed 
with installation

5  When prompted, select your audio drive as 
the install location and click Next to begin the 
install.

6  When installation is complete, click Finish.

The demo session can be opened by double-
clicking the Meant To Be.ptf file located in the 
Pro Tools HD Demo Session folder.

Before installing the demo session to your 
audio drive, make sure your audio drive is 
properly configured as described in the HD 
Setup Guide.



Uninstalling Pro Tools
Use the Uninstall Pro Tools application to unin-
stall Pro Tools software from your computer

To uninstall Pro Tools from your computer:

1  Start Windows, logging in with Administrator 
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2  Do one of the following:

• Insert the Pro Tools Installer disc for Win-
dows in your DVD drive and double-click 
“Uninstall Pro Tools.exe.”

– or –

• If you have already installed the Pro Tools 
upgrade, go to Program Files\Digide-
sign\Pro Tools\Pro Tools Utilities, and 
double-click the “Uninstall Pro Tools.exe” 
file.

3  Click Next.

4  Click Uninstall to proceed with the uninstalla-
tion.

5  When the uninstall has completed, restart 
your computer.
Chapter 3: Installing Pro Tools on Windows 15
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appendix a

Noting Your Preferences
When you upgrade your Pro Tools HD software, 
Pro Tools Preferences settings are reset to their 
default settings. These default settings may dif-
fer from your previous settings. Therefore, you 
may want to note your current Preferences set-
tings before upgrading.

To note your current Preferences settings, you can 
do one the following:

Take a picture, a screenshot, of the existing 
tabbed pages in the Preferences dialog. See “Tak-
ing Screenshots of Your Preferences Pages” on 
page 17.

– or –

Note your preference settings using the tables 
provided in this chapter. See “Preferences Ta-
bles” on page 19.
Taking Screenshots of Your 
Preferences Pages
Mac and Windows both offer the capability of 
taking a screenshot of whatever appears on your 
computer screen. Follow the instructions below 
for your computer platform.

Taking Screenshots on a Mac

Use Mac’s Grab application to take and save 
your screenshots.

To take screenshots of your Preferences pages on 
a Mac:

1  Open Pro Tools and choose Setup > Prefer-
ences.

2  Open the Grab application on your Mac.

3  In Grab, choose Capture > Window.

4  When the Window Grab dialog opens, click 
Choose Window.

5  Click the Preference dialog to take the screen-
shot.

6  In Grab, choose File > Save As to name and 
save the screenshot.

7  Repeat this procedure for each tabbed page in 
the Preferences dialog.
Appendix A: Noting Your Preferences 17
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Taking Screenshots in Windows

Use the Print Screen key on your keyboard to 
take your screenshots, and use the Paint applica-
tion to save them.

To take and save screenshots of your Preferences 
pages in Windows:

1  Open Pro Tools and choose Setup > Prefer-
ences.

2  Press the Print Screen key on your computer’s 
keyboard.

3  Open the Paint application.

4  In Paint, choose Edit > Paste.

5  After the screenshot appears in Paint, choose 
File > Save As to name and save the screenshot.

6  Repeat this procedure for each tabbed page in 
the Preferences dialog.
Upgrading to Pro Tools HD 8.0



Preferences Tables

Display Preferences

Preference Setting

Basics

Track Position Numbers 
Stay with Hidden Tracks

Tools Tips

Function

Details

Edit Window Default Length

Organize Plug-in Menus By

Flat List

Category

Manufacturer

Category and Manufactur-
er

Language

Default Auto-naming to 
English (ASCII)

Meters

Peak Hold

3 Seconds

Infinite

None

Clip Indication

3 Seconds

Infinite

None

Color Coding
Always Display Marker Col-
ors

Midi Note Color Shows 
Velocity

Default Track Color Coding;

None

Tracks and MIDI Channels

Tracks and MIDI Devices

Groups

 Track Type

Default Region Color Coding

Tracks and MIDI Channels

Tracks and MIDI Devices

Track Color

Groups

Marker Locations

Region List Color

Preference Setting
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Operation Preferences

Preference Setting

Transport

Timeline Insertion/Play 
Start Marker Follows Play-
back

Edit Insertion Follows 
Scrub/Shuttle

Audio During Fast 
Forward/Rewind

Latch Forward/Rewind

Play Start Marker Follows 
Timeline Selection

Reserve Voices for Preview 
in Context (Pro Tools HD)

Custom Shuttle Lock Speed

Back/Forward Amount 
(Pro Tools HD)

2 seconds

5 Seconds

10 Seconds

15 Seconds

20 Seconds

30 Seconds

Bars|Beats

Min:Secs

Time Code

Feet+Frames

Samples

Follow Main Time Scale

Numeric Keypad
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Classic

Transport

Shuttle

Use Separate Play and Stop 
Keys

Auto Backup

Enable Session File Auto 
Backup

Keep

Every

Video

Quick Time Playback Priority

Normal

Medium

Highest

High Quality QuickTime 
Image

Avid Video Errors Stop Play-
back (Pro Tools HD with 
Avid Video Engine Only)

Avid Video NTSC Has Setup 
(NTSC-J) (Pro Tools HD with 
Avid Video Engine Only)

Record

Latch Record Enable But-
tons

Link Record and Play Faders

Audio Track RecordLock 
(Pro Tools HD)

Transport RecordLock 
(Pro Tools HD)

Preference Setting



Disable “Input” When Dis-
arming Track (In “Stop”) 
(Pro Tools HD)

Mute Record-Armed Tracks 
While Stopped 
(Pro Tools HD)

PEC/Direct Style Input Mon-
itoring (Pro Tools HD)

Automatically Create New 
Playlists When Loop 
Recording

Online Options

Record Online at Time 
Code (or ADAT) Lock

Record Online at Inser-
tion/Selection

Open-Ended Record Alloca-
tion

Use All Available Space

Limit to

Destructive Punch File 
Length

Misc.

Show Quick Start dialog 
when Pro Tools Starts

Auto Region Fade In/Out 
Length

Calibration Reference Level

Delay Compensation Time 
Mode

Samples

Seconds

Preference Setting
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Editing Preferences

Preference Setting

Regions

Region List Selection Fol-
lows Edit Selections

Edit Selection Follows 
Region List Selection

Auto-Name Separated 
Regions

“Separate Region” Opera-
tions on All Related Takes

Tracks

New Tracks Default to Tick 
Timebase

Memory Locations

Auto-Name Memory Loca-
tions when Playing

Fades

Crossfade Preview Pre-Roll

Crossfade Preview Post-Roll

QuickPunch/TrackPunch 
Crossfade Length

Preserve Fades when Edit-
ing

Default Fade Settings

Fade In...

Fade Out...

Crossfade...

REX...
Upgrading to Pro Tools HD 8.0
Zoom Toggle

Vertical Midi Zoom

selection

last used

Horizontal Zoom

selection

last used

Remove Range Selection 
After Zooming In

Tack Height

last used

medium

large

jumbo

extreme

fit to window

Track View

waveform/notes

warp/notes

last used

no change

Separate Grid Settings 
When Zoomed In

Zoom Toggle Follows Edit 
Selection

Levels of Undo

Preference Setting



Mixing Preferences

Preference Setting

Setup

Sends Default to “–INF”

Send Pans Default to Follow 
Main Pan

Link Mix/Edit Groups 
Enables

Use Absolute Pan Linking

Default EQ

none

TDM plug-in

RTAS plug-in

Default Dynamics

none

TDM plug-in

RTAS plug-in

Automation

Smooth and Thin Data After 
Pass

Degree of Thinning

none 

little

some

more

most

Plug-in Controls Default to 
Auto-Enabled

Suppress Automation 
“Write To...” Warnings
Latching Behavior for 
Switch Controls in “Touch”

Allow Latch Prime in Shop

Coalesce when Removing 
Slaves from VCA Group

Standard VCA Logic for 
Group Attributes

Include Sends in Trim Mode

Include Control Changes in 
Undo Queue

AutoMatch Time

AutoGlide Time

After Write Pass, Switch To

Touch

Latch

No Change

Coalesce Trim Automation

After Every Pass

On Existing Trim Mode

Controllers

Edit WIndow Follows Bank 
Selection

Mix Window Follows Bank 
Selection

“Scroll to Track” Banks Con-
trollers

Always Fill Channel Strips 
when Banking

Touch Timeout

Preference Setting
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Processing Preferences

Preference Setting

AudioSuite

Use AudioSuite Dither

Plug-in

Bit Depth

16 Bits

18 Bits

20 Bits

24 Bits

Import

Convert Imported “.wav” 
Files to AES31/Broadcast 
Wave

Automatically Copy Files on 
Import

Import REX Files as Region 
Groups

Automatically Create 
Fades

Drag and Drop from Desk-
top Conforms to Session 
Template

No Files

REX and ACID Files Only

All Files

Sample Rate Conversion 
Quality

TC/E

TC/E Plug-in

Default Settings
Upgrading to Pro Tools HD 8.0
Elastic Audio

Default Plug-in

Polyphonic

Rhythmic

Monophonic

Varispeed

Default Input Gain

Enable Elastic Audio on 
New Tracks

Preference Setting



MIDI Preferences
 

Preference Setting

Basics

Remove Range Selection 
After Opening the 
MIDI/Score Editor

Use MIDI to Tap Tempo

Display Events as Modified 
by Real-Time Properties

Use F11 Key for Wait for 
Note

Automatically Create Click 
Track in New Sessions

Default Thru Instrument

Pencil Tool Resolution when 
Drawing Controller Data

Global MIDI Playback Offset 
(-10,000 to 10,000)

Double-clicking a MIDI 
Region Opens

MIDI Editor

Score Editor

MIDI Event List

Name Dialog

Note Display

Standard Pitch Middle

Alternate Pitch Middle

MIDI Note Number

Delay Compensation for 
External Devices
MIDI Time Code

MIDI Beat Clock

MIDI/Score Editor Display

Additional Empty Bars in 
the Score Editor

Preference Setting
Appendix A: Noting Your Preferences 25



26
Synchronization Preferences

Preference Setting

Machine Control

Machine CHases Memory 
Locations

Machine Follows Edit/Inser-
tion Scrub

Linear Devices (jog)

Non-Linear Devices (cue)

Machine Cues Intelligently

Stop at Shuttle Speed Zero

Non-Linear Transport Error 
Suppression

Synchronization

Minimum Sync Delay

Delay before Locking to Lon-
gitudinal Time Code

Delay before Locking to 
Serial Time Code

Remote Mode

Ignore Track Arming

Set Servo Lock Bit at Play

Allow Track Arm Commands 
in Local Mode

Punch in Frame Offset

Punch Out Frame Offset

Delay after Play Command

Satellites

Transmit Solos

Receive Solos
Upgrading to Pro Tools HD 8.0
Solo Independent Of Linked 
State

DAE Errors Stop All Linked 
Systems

Transmit Play Selections

Receive Play Selections

Preference Setting
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